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Overview of the Enhanced Q-Box RP1LP Low Range Respiration Package 

The enhanced Q-Box RP1LP package can be used to measure the metabolic rate of small animals or less 

active animals such as reptiles, amphibians, insects and other invertebrates in both open, and stop flow 

modes. A system diagram is shown below. Open flow measurements are used for more metabolically 

active samples. Although the open mode gives continuous, fast response data, it has lower sensitivity 

than the stop flow configuration. Open flow uses the difference between the sample and reference 

gases to calculate CO2 production (𝑉̇CO2) and oxygen consumption (𝑉̇O2). For very small or metabolically 

inactive specimens, the system can be used in a stop flow configuration.  Since the gas analyzers 

measure partial pressure, their readings are pressure corrected for changes to pressure due to weather, 

or any back pressure created in the system.  Pressure in the gas system is measured by the Q-S102 O2 

Analyzer pressure sensor. The stop flow and open flow methods have the advantage over closed flow 

systems that the gas analyzers remain at atmospheric pressure. By using a pair of 3-way solenoid valves 

controlled by a pulse width modulated signal (PWM; generated by Logger Pro software) via a digital 

control unit (DCU), flow through the chamber is periodically stopped when the solenoid valves are 

energized.  During this time the chamber is bypassed to provide background measurements of CO2 and 

O2. Meanwhile, respiration gases from the specimen either accumulate or are depleted in the chamber 

and when solenoid valves become de-energized the chamber is flushed with background gas and 

respiration gases are swept to the gas analyzers for measurement.  The stop flow method uses the 

integral of the measured bolus of gases that build up or are depleted during the stop time to calculate 

CO2 production (𝑉̇CO2) and oxygen consumption (𝑉̇O2).  The enhanced RP1LP system includes 

automation of the open and stop flow methods including all the calculations in the software.   

The gas is pumped through the system at a known flow by the Q-P103 Gas Pump. The flow is adjusted 

and measured by the Q-G266 Flow Monitor. The concentration of CO2 and O2 in the reference (i.e. 

carrier) gas supplied to the animal chamber, is determined during chamber bypass by the Q-S151 

infrared CO2 gas analyzer (0-2000ppm range), and the fuel cell Q-S102 O2 Analyzer (0-25% range). The 

concentration of CO2 and O2 in the gas flowing through the chamber (modified by specimen respiration), 

is determined when the 3-way solenoid valves (A380-E) are deenergized and the chamber is flushed.  

Analog voltages from all of the sensors are converted to digital signals via two LabQuest Mini interfaces 

(6 analog + 4 digital channels).  Control A380-E solenoid valves is programmed in Logger Pro software 

experimental file (Enhanced Q-Box RP1LP Setup) in conjunction with a DCU (C200), connected to a 

digital channel on a data interface. Data are displayed, recorded and manipulated on a PC or Macintosh 

computer using Logger Pro. Metabolic rates are calculated by the software from the changes in O2 and 

CO2 for both open and stop flow.    

The enhanced Q-Box RP1LP also includes a temperature sensor (S174) which can be placed inside the 

animal chamber, to investigate the effect of temperature on metabolic rate.  Metabolic rates measured 

at different temperatures can be corrected by the user to a standard temperature, assuming a given Q10. 

In addition, the enhanced Q-Box RP1LP can be used to investigate animal metabolic responses to 

exercise, to different diets, to pharmaceuticals and to various concentrations of O2 and CO2 in the carrier 

gas supplied to the chamber.  Gas mixtures can be supplied via 2 large gas bags (G122 included). For 

longer experiments such as hibernation studies, gas can be obtained from a commercial tank with a 

regulator. Qubit also manufactures gas mixing equipment that can be used for this application. 

This enhanced Package can be used for measurements of CO2 and O2 in fungi and micro-organisms. 

Other potential applications include measurements of metabolism from aquatic suspensions.  For 
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example, yeast or bacterial growth can be studied, by bubbling air through a culture suspension to 

analyze the headspace gas.  Gas can also be analyzed from a soil chamber. 

 

Components of the Enhanced Q-Box RP1LP  
 

Q-S151 CO2 Analyzer (Range:  0-2000 ppm)   

Q-S102 O2 Analyzer with pressure sensor for O2 pressure correction (Range:  0-100%, 0-25%)  

Drying columns for Q-S151 and Q-S102 with DRIERITE (blue) (3x) (Q11784)   

Small drying column  

CO2 scrubbing column with soda lime (white) (Q13025)   

Q-G266 Flow Monitor (Range: 0 -1 LPM)   

Q-P103 Gas Pump (1 LPM no load)  

G115-E Flow-through Chamber for enhanced package (3.8 cm ID x 20 cm L)   

G117 variable volume Glass and Aluminum flow through chamber (1.9 cm ID, adjustable length) for 

small samples   

C200 Digital Control Unit (DCU ) 

A380-E Three-way solenoid valve assembly for Stop Flow  

S174 Thermistor Temperature Probe for enhanced Q-Box RP1LP  

G122 Large Gas Bags (30 Litres x 2)  

Integrated C610 LabQuest Mini Data Acquisition Interfaces (2x), 6 analog + 4 digital channels  

C901 Logger Pro Data Acquisition Software  

C404 Customized Setup files  

Q-Box Accessory Kit (includes tubing, filters, connectors, wool, wrench for needle valve adjustment, 

screwdriver, qubitac sealant)  

Manual  

Individual power supplies for all the sensors (for use in stand-alone mode)  

Rugged weather-proof case  

A249 Battery Pack for field work (OPTIONAL)  
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Schematic of Enhanced Q-Box RP1LP Setup 
 

Note: heavy blue lines indicate gas flow; thin black lines indicate electrical connections. The 3-way 

solenoids are shown in the failsafe default state (not energized; PWM=0) with flow through the 

chamber. PWM is the pulse width modulated signal programmed in software that controls the 3-way 

solenoids via the DCU (digital control unit). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The method of stop and open flow used in this package is explained below using the following CO2 and 
O2 time plots obtained with 8 mealworms inside a G117 chamber adjusted to 6.3 ml. In the Stop Flow 
setup with PWM=0 during collection (and when the software is not collecting data, i.e. during setup of 
an experiment or during a power failure), the 3-way solenoid valves are not energized. The carrier gas 
(CO2-scrubbed and dried outside air in this example) flows through the chamber. Note this state is 
default so that when the solenoids are not powered (e.g. during a power outage), this is a safety feature 
to ensure the specimen has carrier gas flowing past it to avoid excessive CO2 buildup and O2 depletion. 
This is very important during setup of the experiment.  When solenoid valves become energized and the 
chamber gas is swept through the analyzers, a CO2 peak and an O2 trough appear on the graphs as a 
result of CO2 build up and O2 depletion during the previous stop phase (i.e. PWM=1; bypass of the 
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chamber with specimen). Once the CO2 peak and O2 trough have passed through the analyzers, the 
measured gas concentrations will return to the steady state open flow values.  If the specimen is active, 
these values may be different enough from the reference levels that open flow calculations of O2 
consumption ( O2) and CO2 production ( CO2) may be obtained from this difference. In the stop flow 
setup, O2 and CO2 are calculated from the area under the peak (CO2) or above the trough (O2).   
In the enhanced Q-Box RP1LP package, O2 and CO2 are computed continuously (i.e. for every sample 
time) during the open flow configuration and only once per stop/flush cycle - at the end of the stop 
peak/trough during the stop flow configuration. 
When PWM=1 the 3-way solenoid valves are energized by the DCU to bypass carrier gas around the 
chamber to the analyzers to give a background measurement of CO2 (0 ppm) and O2 (20.95 %). 
Interpolation between the background samples is performed in the software to remove any drift in the 
background. This is especially useful for long experiments where temperature, pressure or humidity may 
change. Consequently, although stop flow has a better sensitivity for small samples such as insects, it 
has a slower time response compared to open flow. Open flow is more suited to continuously following 
larger specimen activity. 
 

Important Notes:  

1) Automatic calculations of O2 and CO2 for open flow and stop flow are presented on Pages 2 and 3, 

respectively, of the experimental setup file in Logger Pro. These automatic calculations permit long term 

monitoring of respiration.  2) If CO2 measurements are not possible to obtain during stop flow 

configuration, i.e. CO2 peak may exceed the 2000 ppm limit of the CO2 analyzer (when the specimen is 

very active or stop flow period is too long) the open flow configuration may be more appropriate to use. 

3) This package may also be used as a standard Q-Box RP1LP package when active specimens are studied 

(i.e. without the solenoid valves and digital control unit; see standard Q-Box RP1LP Low range 

respiration manual for instructions).  4) The O2 and CO2 changes during stop flow configuration may be 

increased by a longer stop time and smaller chamber volume. 5) During open flow configuration 

differences between the reference and sample gases may be enhanced by reducing the gas flow 

through the system. 6) For accurate recording of the data during stop flow configuration, gas flow 

should be low enough (~ 25 ml/min) so that the gas sensors (response time ~ 20 sec) to register the 

peaks being swept through them. 7) In addition to the automatic calculation of O2 and CO2  on Pages 

2, 3 of the Logger Pro experimental file, templates for manual calculation are provided on Pages 4, 5.  

These are most useful for educational purposes and manual check on the automatic calculations. 

It is extremely important to properly set the user parameters on Logger Pro Page 1 so that the 

automatic calculations are performed correctly for a specific experiment flow, flush and stop 

time etc.  
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Stop Flow and Open flow Signals in Enhanced Q-Box RP1LP 
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Quick Start Up Steps:  

1. Load Logger Pro 3 software onto the computer (see page 35).    

2. Load C404 customized experimental files (see page 37).  

3. Connect the Q-Box to a power supply (or A249 Battery pack for field use).  

4. Turn on the pump (Q-P103), flow monitor (Q-G266), CO2 analyzer (Q-S151) and O2 analyzer (Q-

S102).   

5. Allow the Q-S151 CO2 and Q-S102 analyzers to warm up for at least 30 min.  

6. Connect the DCU to the 3-way solenoid valve assembly (A380-E). 

7. Connect two USB cables from the Q-Box frame to the computer. Two audible sounds may be 

heard as the two interfaces are recognized.  Ensure that USB1 is plugged in first and USB2 is 

plugged in second, with time in between so the two interfaces are recognized in the correct 

order.  

8. Open the “Enhanced Q-Box RP1LP Setup” file copied from the C404 disk, to start Logger Pro 

software.  the following sensor connection window will be shown: 

 

 

9. Assign the sensors to appropriate channels on the 2 data interfaces as follows:  

a. Ch. 1 LabQuest Mini 1 - Q-S151 CO2 Analyzer  

b. Ch. 2 LabQuest Mini 1 - Q-S102 P (gas pressure kPa)  

c. Ch. 1 LabQuest Mini 2 - Q-S102 O2 Analyzer (O2 kPa)  

d. Ch. 2 LabQuest Mini 2 - Q-G266 Flow Monitor (V)  
e. Dig.1 LabQuest Mini 2 - DCU 
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Note: Ch. 3 LabQuest Mini 1 automatically recognizes the temperature sensor and the digital control 

unit. The configuration of the sensor connections is shown in a text box at the bottom of Page 1 in 

Logger Pro.    

 
 

 

Note: If Logger Pro does not recognize the two data interfaces (LabQuest Minis) in correct order and 

switches them, this will likely result in unrealistic readings for the sensors, since they will be assigned 

to the wrong channels and hence have incorrect calibrations. If this occurs, the user should first open 

the experimental Setup file without USB1 and USB2 connected. Once the sensor confirmation screen 

opens, USB1 cable may be connected first (allow few seconds for the software to recognize it - a star 

appears in the top left corner of the menu) then USB2 cable connection may follow. This method 

should force the minis to be recognized in the correct order. 

 

 

Check the system plumbing by removing the tray with all the sensors from the Q-Box, and place it 

outside of the box as shown in the photo below.   The system should be configured as shown by the 

photo and diagram below. 

 

 

10. Connect the carrier (i.e.  reference) gas source (gas bag or other constant source of CO2) 

to the “in” port on the Gas Pump via a blue particulate filter.   
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The gas source can be a gas bag of CO2-free air filled from a commercial tank of air. An 

alternative is to use dried outside air (dried with the Drierite column) which has a 

constant CO2 level of ~ 400 ppm and O2 concentration of 20.95%. Do not use inside 

room air which has significant fluctuations of CO2 due to human breath. Dried outside 

or inside air can be scrubbed of CO2 using the soda lime column, if CO2-free air is needed.   

Note: If the gas source is pressurized (e.g. tank) do not connect pressurized gas to the 

pump.  Instead, as shown below, reduce the regulator pressure to a couple of psi and 

connect the gas line to a luer “tee” piece. Connect the pump to one of the other “tee” 

ports and let excess gas vent (feel on skin) from the third port of the tee piece. To 

conserve gas, if a rotameter is available, place it before the “tee” and adjust the flow 

with its valve to ~ twice that required by the pump. The pump then supplies gas at 

whatever flow is determined by the pump and flow monitor valves.  

 

 

 

 

 

 

 

 

 

11. Connect the “out” port of the Gas Pump to the “in” port of the Q-G266 Flow Monitor.   

 

Note: The 3-way solenoid valve assembly (A380-E) are installed as in the above schematic 
diagram of the enhanced RP1LP (Page 5) to direct the flow of gas either through the 
animal chamber (de-energized; PWM=0) to obtain a measurement, or to bypass the 
chamber (energized; PWM=1) to obtain reference levels.   
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The screen shot below shows how the DCU is programmed to control the 3-way solenoid 

valves. This may be viewed by clicking on the star icon for Mini 2 under the top menu in 

Logger Pro. Next click on the DCU symbol and open the Digital Out. The DCU/3-way 

solenoid combination can be manually tested by checking “Line 1 On”. 

 

 
 

12. Connect the “out” port of A380-E to the “in” port of the Q-S151 CO2 Analyzer via the 

Drying Column (blue DRIERITE) and a blue filter.   

Note: Brand new Drierite may absorb and then slowly release some CO2, thereby 

widening CO2 stop flow peaks. It is strongly recommended to use Magnesium 



12  

  

perchlorate rather than Drierite to remove water vapour released by the specimen, in 

order to avoid O2 dilution by this water vapour.  

 Only one drying column needs to be used when the Q-S151 and Q-S102 are used in 

series.  A second drying column is provided for stand-alone use of the Q-S102. Two 

columns in series are recommended with very wet samples.  

a. Connect the “out” port of the Q-S151 CO2 Analyzer to the “in” port of the Q-S102 O2 

Analyzer.  

b. Gas vents from the O2 analyzer via the “out” port.    

c. Two blue filters should be placed in the gas line, one before the pump and one before 

the CO2 analyzer, to prevent particulate dust from the columns entering the analyzers.  

 

Open Flow (PWM=0): The chamber is flushed with reference gas to sweep out the CO2 and O2 from the 

chamber.   The accumulation of CO2 will be graphed as a positive bolus whereas the reduction in O2 is 

seen as a negative bolus or trough. 

 

 

 

 

 

 

 

   

 

 

O2 consumption ( O2) and CO2 production ( CO2) are computed from the difference between sample 

and reference gases for O2 and CO2 respectively in the open flow calculation. For the stop flow 

computation, they are calculated from the area (i.e. integral) of the stop flow peaks for O2 and CO2. 

Stop Flow (PWM=1): The chamber is bypassed (i.e. gas flow through the chamber is stopped). CO2 will 

increase and O2 will decrease in the chamber due to the animal’s respiration.  
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13. Set the gas flow through the system.   

It is recommended that the gas sensors be calibrated at the same flow and temperature as that 

used in experimental measurements. To allow time for the gas sensors (response time ~ 20 sec) to 

respond to passing stop flow peaks, the flow should be low (~ 25 ml/min). In the open flow or steady 

state signal, after the stop flow peak has passed, the CO2 and O2 differentials (with respect to the 

reference gas) depend inversely on flow, hence larger differences can be obtained by lowering the 

flow. A higher flow should be used when higher rates of respiration are measured.  The flow rates 

through the system are set with the Flow monitor (Q-G266) valve.  The gas pump has been set at 

manufacture and when used with the Q-Box RP1LP does not need any adjustments.  

To set the flow through the system, use the valve on Q-G266 Flow Monitor.  First, unlock the locking 

nut of the valve with the 8 mm wrench provided in the accessory pack. Next, fully close the valve 

(clock-wise) and observe a 0 L/min flow in the Q-G266 Flow meter on bottom left hand side of Logger 

Pro Page 1. Then, slowly open the valve (counter clock-wise) until desired flow rate is reached. Use 

the 8mm wrench, to lock the by turning the locking nut on the Flow Monitor.  This will avoid 

accidental change of flows.  Flow is recorded in software.  The tray holding all the sensors can then 

be placed back in the Q-Box. 
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The Q-G266 Flow Monitor and S174 Temperature Sensor are factory calibrated and no additional 

calibrations are required.  The calibration of the Q-S151 CO2 Analyzer and Q-S102 O2 Analyzer 

should be checked at the start of each day of experiments.  Both Analyzers have linear 

responses, hence they only require 2 point calibrations.  The first point should be zero 

concentration, and the second point (span) should be a standard CO2 or O2 concentration near the 

upper part of the range at which the analyzer will be used.  

14. Calibration of the Q-S151 CO2 analyzer (two point calibration):  
a. Set the CO2 analyzer in the 0 – 2000 ppm range which is the default range used with the 

Enhanced Q-Box RP1LP package.  

b. Supply CO2-free air to the analyzer by attaching the soda lime column to the outlet of 

the flow monitor.  Attach the outlet of the soda lime column to the inlet of the drying 

column.  Both the soda lime and drying columns should be vertical to ensure maximal 

contact of the gas with the particles.  The outlet of the drying column should be 

attached to the inlet of the CO2 analyzer. Soda lime will scrub CO2 from air and provide 

the zero reading (the first point of the calibration).  

c. From the menu in Logger Pro Software, select Experiment>Calibrate>LabQuest Mini  

1>Q-S151 CO2 Analyzer (2000ppm).  A dialog box will appear as shown below.  Select 

the calibration storage as “Computer” then click “Done”.    

 

  

Locking nut    
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d. When the reading on the CO2 analyzer is stable, use the small green screwdriver 

provided to adjust the “CO2 Zero” control on the analyzer to set its digital display to 000 

CO2.  The Q-S151 CO2 meter in the software Page 1 should also read zero. 
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e. If the zero reading is highly out of range (by more than 40 ppm), or if the maximum or 

minimum position of the “CO2 Zero” has been reached (i.e. turning the control has no 

effect), use the “Coarse Zero” adjustment on the back of the instrument to bring zero 

within range.  Use the “Coarse Zero” with caution, since very small adjustments result 

in large changes. Also, there is a delay in response to changes in “Coarse Zero”.  If use 

of the Coarse Zero is necessary, first adjust the fine zero to the middle of its range.  Do 

this by turning the “CO2 Zero” potentiometer on the front of the analyzer clockwise or 

counter-clockwise to the end of its range (it will click when this is reached).  Then turn 

the potentiometer twelve complete turns in the opposite direction.  The CO2 Zero 

control is now centered. Use the Coarse Zero to bring the reading close to Zero. Then 

use the “CO2 Zero” on the front of the analyzer to make the final zero adjustment.   

 

 
 

f. Remove the soda lime column from the gas line. Attach the “in” port of the Q-P103 Gas 

Pump to the gas bag or tank with known CO2 concentration.  Allow the reading to 

stabilize. 
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g. If the Q-S151 display does not show the concentration of CO2 that is in the calibration 

gas, adjust the “CO2 Span” control until the display shows the CO2 concentration 

supplied to the analyzer.  The CO2 readings in the Logger Pro experimental file should 

match that on the digital display of the CO2 analyzer.    

h. If a significant adjustment was made to the “CO2 Span”, return to the zero check and 

ensure the zero reading has not shifted.   

i. If the readings on the Q-S151 digital display are significantly different from those on the 

Q-S151 CO2 meter in the software, first check that the correct range (2000ppm) is 

selected on the CO2 analyzer and the correct CO2 range (Q-S151 CO2 Analyzer 2000ppm) 

has been selected in the experimental file.  If these are correct and the readings are 

mismatched by more than ~10ppm, then proceed to calibration of the CO2 analyzer in 

the software as described below.  

Calibration of the CO2 analyzer in software (to be used only if the display reading and the 

software readings are significantly mismatched)  

a. Supply CO2-free air to the analyzer by attaching the soda lime column to the outlet 

of the flow monitor.  Attach the outlet of the soda lime column to the inlet of the 

drying column.  Both the soda lime and drying columns should be vertical to ensure 

maximal contact of the gas with the particles.  The outlet of the drying column 

should be attached to the inlet of the CO2 analyzer. Soda lime will scrub CO2 from 

air and provide the zero reading (the first point of the calibration).  

b. From the menu in Logger Pro Software, select Experiment>Calibrate>LabQuest 

Mini 1>Q-S151 CO2 Analyzer (2000ppm).  A dialog box will appear as shown below.  

Select the calibration storage as “Experiment File” so the calibration is saved with 

the current file.    

 

c. Proceed to “Calibrate” in the same window (see below).  Ensure the Current 

Calibration is selected as Q-S151 CO2 Analyzer 2000ppm <Experiment>.  This 

selection will ensure that the calibration is saved with the Experiment file. 
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d. When the reading on the CO2 analyzer is stable, use the small green screwdriver 

provided to adjust the “CO2 Zero” control on the analyzer (if needed) to set the digital 

display to read 000 CO2. In software, enter “Reading 1” as 0 and  click “Keep” 

e. Remove the soda lime column from the gas line. Attach the “in” port of the Q-P103 

Gas Pump to a gas bag or tank with known CO2 concentration.  

f. If the Q-S151 display does not show the correct concentration of CO2 in the 

calibration gas, adjust the display using the “CO2 Span” control.  When the Q-S151 

CO2 display shows the correct CO2 concentration, enter that concentration as 

“Reading 2” in software and click “Keep” then “Done”.  Save the experimental file 

under a new name so the new calibration is saved with the current file.  The CO2 

readings in Logger Pro software should now match those on the digital display of the 

CO2 analyzer.    

 

15. Calibration of the Q-S102 O2 analyzer:  

Note the Q-S102 analyzer measures partial pressure of O2 (Q-S102 O2; kPa) as well as total gas 

pressure in the analyzer (Q-S102 Pres; kPa).  Normally Q-S102 Pres is close to atmospheric 

pressure if the analyzer vents to atmosphere.  The partial pressure of O2 will follow atmospheric 

pressure changes (i.e. weather) and altitude, whereas the concentration is constant and 

independent of pressure variation. The analyzer O2 partial pressure reading is corrected in 

software for changes in total gas pressure to produce O2 (Pcor) reading in % units.  These 

corrected readings (see calculation below) are displayed in the software in a meter.   

O2 (Pcor) = ((Q-S102 O2 )/(Q-S102 Pres))*100  

 

Where Q-S102 O2 is the O2 partial pressure, and Q-S102 Pres is the (total) gas pressure 

measured inside the QS102 O2 analyzer.   
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To check and adjust the calibration of the Q-S102, follow these steps:  

a. Set the O2 analyzer in the 0 – 25 KPa range. This is the default range for measurements 

of respiratory O2 consumption with the Q-Box RP1LP.  Ensure the current calibration is 

selected as Q-S102 O2 Sensor 25KPa< Computer> then click Done. 

 

 

b. Supply O2-free gas (e.g. N2) to the analyzer by attaching the O2-free gas source (i.e. 

gas bag) to the “In” port of the Q-P103 Pump.  As the O2-free gas enters the Q-S102 

O2 Analyzer, O2 (Pcor) in the software on Page 1 will decrease toward zero (the first 

point of the calibration)  

c. When the reading in the software is stable, use the small green screwdriver to adjust 

the “O2 Zero” control on the analyzer until the O2 (Pcor) meter in the software reads 

0.0 % O2.    
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d. Attach the “In” port of the Q-P103 Gas Pump to a source of gas with known O2 

concentration (i.e. gas bag or air tank). Alternatively, dried room air contains 20.95% 

O2.  

e. When the O2 (Pcor) reading in software becomes stable, adjust the “O2 Span” control 

on the analyzer until the reading of O2 (Pcor) corresponds to the O2 concentration 

supplied to the analyzer.    

 
 

 

f. If a significant adjustment had to be made to “O2 Span”, return to the zero check and 

ensure that the zero reading on the analyzer has not shifted.  It is not necessary to do 

the zero check while in the calibration mode of the software.  

  

Total gas pressure 
at the O2 sensor (kPa) 

O2 concentration 
Corrected for 
Changes in gas 
Pressure (%) 
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16. Assemble the flow through animal chamber by placing the S174 temperature probe 

(with O-rings) in the opening of the end cap as shown.  If the temperature probe 

requires additional sealing around the opening, use the blue Qubitac sealant provided in 

the accessory kit.  If the temperature probe is not used, ensure the hole is plugged by 

the included metal rod with o-rings. Insert the rod or temperature probe to the bottom of 

the channel so small specimens cannot enter this channel from the chamber.  

 

 

17. Place the animal(s) in the chamber and attach the chamber and the solenoid assembly to 

the system as shown below.  

  

 
 

18. Before collecting data with Logger Pro software, select Experiment > Data Collection in 

the main menu.  The following dialog box will appear:  
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Input experiment length and data sampling rate as required.  For long experiments, the sample 

rate may need to be lowered to accommodate the large amount of data collected and processed 

online. 

NOTE: Do not change the units of time i.e. keep minutes as the unit. 

Select: File> Save As to save the experiment settings under the file name selected so that the 

original Experiment file (Enhanced Q-Box RP1LP Setup) is not over- written.   

19. Start data collection by clicking the green “Collect” button, and stop data collection by 

clicking the red “Stop” button (green turns red during data collection)  

 

 

 

20. Logger Pro displays data on Page 1 “Raw Data” as they are collected in graphs, meters 

and spreadsheet columns.  Sample data from an experiment with 8 mealworms in a 

G117 chamber adjusted to 6.3 ml is shown below. CO2-scrubbed and dried outside air 

was used as the carrier gas flowing at 25 ml/min. A 13 ml magnesium perchlorate 

column was used to dry the sample gas entering the gas analyzers. 
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21. Before proceeding with an experiment the user must very carefully set the user 

parameters on Page 1 of the experimental Setup file. This ensures data can be 

automatically used in open and stop flow calculations and these are performed 

correctly.  The user parameters may be changed by toggling the arrows of the right or by 

double clicking and typing the desired value. 

 

 
 

This is most easily done by collecting a short period of data and expanding the 

differential graph on Page 1 of the setup file to show a single flush-stop cycle as shown 

below.  
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FlushTime (PWM=0):  Choose this time period to be long enough so that after the stop 

peaks have passed through the gas analyzers, steady state open flow is achieved.  

StopTime (PWM=1): Select this time to be long enough to obtain suitable stop peaks 

without exceeding the 2000 ppm limit of the CO2 analyzer (unless only the open flow 

measurements are of interest for an active animal).  

Note: There is a washout time after switching (~1 min in data shown above) before fresh 

gas reaches the gas analyzers. Both the flush and stop times will be influenced by carrier 

gas flow and specimen activity. 

EventTime: At the end of the flush and stop phases, data is averaged over the EventTime 

prior to the switch. This event average is recorded at the time of switching shown by the 

large dark red dots at the top of the above graph (i.e. FlagEv). The event flag at the end 

of the stop phase (i.e. end of flush-stop cycle) is shown by an orange triangle (i.e. 

FlagRef). 

O2delay: Since the O2 analyzer follows the CO2 analyzer in the setup, gas reaches the O2 

analyzer after passing through the CO2 analyzer. Thus the O2 signal is delayed with 

respect to the CO2. Calculations of  𝑉̇CO2 and 𝑉̇O2 require both CO2 and O2 signals, hence 

these must be aligned (i.e. O2 shifted) by setting the O2delay user parameter. Alignment 

is done by placing a vertical line (menu: Analyze>Examine) on the CO2 peak and 

adjusting O2delay by how many sample points were measured.  As this number is 

increased or decreased the O2 shifts into alignment with the CO2 signal.  

FlushTime StopTime 

Open Flow 

Stop Peak 

FlagLow 
FlagHigh 

FlagEv 

FlagRef 

PWM 

EventTime 
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Note: Delay of the O2 signal  depends on gas flow and length of tubing between the gas 

analyzers so it will differ with experiments. 

DelayHigh: The DelayHigh and DelayLow user parameters pertain to stop flow 

calculations and determine how accurately peak integrals are automatically computed 

for use in the stop flow calculations of 𝑉̇CO2 and 𝑉̇O2 on Page 3 of the setup file. 

DelayHigh can be adjusted by placing the cursor cross hairs on the time axis at the 

beginning of the flush phase (PWM=0) holding the left mouse button and sweeping to a 

time after the stop peaks where steady state has been achieved. The swept area will be 

greyed as shown in the image below. Determine the Δx from the lower left time axis (in 

the graph below it is 1.91) and adjust DelayHigh to this value. The end of DelayHigh is 

indicated by a green dot on the top of the graph (i.e FlagHigh). 

Note: The placement of FlagHigh is not critical since the concentration levels of CO2 and 

O2 are fairly constant after the stop peak  recording, unless the specimen has rapid 

changes in respiration.  

 

 

 
 

DelayLow: This user parameter must be chosen extremely carefully so the area under 

CO2 peak or above O2 through is correctly calculated. As explained above in 

determining DelayHigh, use the cursor to sweep data from the beginning of the flush 

phase (PWM=0) to a point on the left side of the CO2 peak where steady state open flow 

levels are being measured (see the data shown below). The value of Δx shown in the 

lower left side is the DelayLow (0.76 in example below).  Enter this value or adjust 

DelayLow user parameter to this value. The end of DelayLow period is indicated by a 

black dot at the top of the graph (i.e. FlagLow). 
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Now the user can now proceed with collecting data for an experiment. 

Note: FlushTime and StopTime parameters cannot be changed during or after 

completion of an experiment. These user parameters have to be set before start of the 

experiment.  O2delay, DelayHigh and DelayLow parameters may be adjusted after 

completion of an experiment.  

 

22. During the experiment, the range of the x and y axes can be adjusted by clicking on the 

lowest or highest number and typing in the desired new value as shown in the following 

diagram.  
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23. During collection of data, calculations of CO2 and O2 are done automatically in Logger 

Pro for both open flow differences and stop flow peaks/trough areas in the flush phase.  

Open Flow calculations are graphed for each sample time (i.e. instantaneously) during 

the flush phase (i.e. FlagHigh to FlagEv) and are displayed on Page 2 of the setup 

experimental file. These calculations use differences in concentration of CO2 and O2 

measured during flush phase and interpolated reference gas concentrations from those 

measured during stop periods. A long flush time will provide a long open flow period 

after the stop flow peak/trough is recorded, where activity of a sample can be followed 

continuously.  

The stop flow measurements can be optimized with long stop times.  Calculations of 

CO2 and O2 are done using the area of the stop flow peak/trough and are displayed on 

page 3 of the setup experimental file.  Stop flow measurements are more useful for 

smaller and less active specimens. One stop flow calculation per cycle is recorded and 

graphed at the end of each peak (i.e. at FlagHigh). As a result, the total cycle time (stop 

plus flush time) determines the time response for stop flow measurements. As a result, 

the time resolution is sacrificed for sensitivity in stop flow calculations. If frequent stop 

flow measurements are required for best time response then a short flush time should 

be selected which is just sufficient to record the full peak/trough.  Only peak area and 

stop time are required for stop flow calculations of CO2 and O2. Chamber volume 

should be minimized to be just large enough to comfortably contain the specimen.  

Reducing chamber volume will not change the peak area but the peak height will 

increase and the peak width will decrease with chamber volume reduction allowing 

Santiago estop flow calculations.  Gas flow should be low (~25 ml/min) so the gas 

analyzers (~20 sec response time) can respond to the peak washing through. 

 

Upon completion of the experiment, the data can also be analyzed manually (i.e. offline), in 

Logger Pro using the various analysis tools in the Analyze menu, or by selecting the analysis icons 

in the top menu. Calculations for open flow can be done manually in the Logger Pro template on 

Page 4 (open flow calculations) or for stop flow on Page 5 (stop flow calculations).  These 

manual calculation templates are intended for educational applications where the students can 

see all the steps of the computations. These manual calculations also provide a secondary check 

on the automatic calculations which are dependent on the user parameters set on Page 1. 

Note: The data can also be directly exported as a text file (File > Export As > text), which 

can then be opened in a worksheet such as Excel for further analysis and calculations. 

  
Calculations of Metabolic Rates ( CO2 and O2):  
  

Overview 

 

Measurements of metabolic rates are expressed as rates of CO2 produced per unit time ( CO2), 

or as O2 consumed per unit time (  O2).  The units are µl/min which can be converted by the 

user to µmol/min. Respiratory Quotient, RQ, is the ratio of CO2 produced to O2 consumed (i.e. 



28  

  

RQ= CO2/  O2). RQ is directly related to the animal’s diet and metabolic condition.  RQ is 

usually less than 1.0, which means that more O2 is consumed than CO2 produced.     

The incurrent CO2 and O2 concentrations (i.e. reference gas entering the chamber) are measured 

throughout the stop (i.e. bypass) phase, averaged over the EventTime and recorded at the end 

of the stop phase (i.e. at FlagRef). These event averages are interpolated to provide CO2Ref and 

O2Ref for every sample time. The excurrent concentrations (i.e. respiration-modified gas exiting 

the chamber) are measured during the flush phase. The interpolated reference values are 

subtracted to provide the differentials (i.e. difCO2, difO2). These differentials are used to 

calculate the open flow CO2 and  O2. Only peak volumes (calculated using differential flow) 

and stop time are required for stop flow computation of CO2 and O2. 

 

Open Flow Calculations of CO2 and O2 
 

Open Flow (Automatic; Page 2 of Setup file): 

 

The automatic open flow measurements are useful for long term, high time resolution 

monitoring of respiration where the animal is active enough for the open flow signal (i.e. 

difference between reference and sample gases) to be accurately measured. In the automatic, 

open flow calculations (Page 2 in Setup Experimental file), the instantaneous (i.e. at each 

sample time) incurrent concentrations of gases are obtained from the background 

measurements during the stop (i.e. bypass) periods. These reference samples are linearly 

interpolated to provide a continuous (i.e. at each sample time) background levels to remove 

any drift in the signal. This is done for both CO2 and O2 but is most useful for the O2 data since 

O2 differentials (ppm) are measured in the air background of ~21%=210,000 ppm. CO2 

background in outside air is only ~400 ppm. The CO2 analyzer has a resolution of ~ 1 ppm 

whereas the O2 resolution is ~ 40 ppm. The IR CO2 sensor is temperature controlled whereas 

the fuel cell O2 sensor has passive temperature control  and is more prone to temperature-

induced drift.  The interpolated O2 background is shown by the dark blue O2Ref(%) line in the 

following screen capture for an experiment with 8 mealworms in a 6.3 ml G117 chamber using 

CO2-scrubbed and dried outside air flowing at 25 ml/min. The excurrent levels are obtained at 

each sample time during the open flow steady state part of the flush periods after the stop peak 

has washed through the gas analyzers. The equations used to calculate CO2 and O2 are the 

same as those presented below for the manual open flow calculations on Page 4 in the Setup 

experimental file.  
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CO2 and O2 differentials (excurrent minus interpolated(incurrent)) are shown in the following 

differential graph from Page 1 (Raw Data) of Setup file. Any background drift has been removed 

by the interpolation between the reference samples obtained in the stop periods. These 

differences (difCO2, difO2) form the basis of both open and stop flow calculations of CO2 and 

O2.  

 

 
 

The screen capture below shows the automatic open flow calculations found on Page 2 of the 

Setup file. Note the  CO2,  O2 and RQ values are retained only for the open flow portion of the 
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flush phases after the stop peaks have washed trough the gas analyzers (i.e. between FlagHigh 

and FlagEv). 

  

 
 

Open Flow (Manual; Page 4 of Setup file): 

 

Manual open flow calculations are intended for short term respiration experiments or for teaching 

purposes where the open flow method is applicable i.e. the difference in signal between reference 

and sample is substantial. Since the flow monitor in the Q-Box RP1LP package is upstream of the 

CO2 and O2 analyzers, and CO2 or O2 are not removed from the excurrent gas stream, the following 

equations are used to calculate CO2 and O2:   

 

Lighton, J.R.B. (2008): “Measuring Metabolic Rates. A Manual for Scientists. Oxford University 

Press 

(http://warthog.ucr.edu/WartHogPage/LAX%20website/respirometry.html)  

  

Dilution of CO2 due to the concentration of O2, is accounted for in the CO2 calculation and the 

concentration of CO2 is accounted for in the O2 calculation as shown in the following equations:  

CO2 = FR * ((FeCO2 – FiCO2) – FeCO2 * (FiO2 – FeO2))/(1 - FeCO2)  

O2 = FR * ((FiO2 – FeO2) – FeO2 * (FeCO2-FiCO2))/(1 – FeO2)  

Where FeCO2 is the fractional excurrent CO2 concentration, and FiCO2 is the fractional incurrent CO2.  

FeCO2 = eCO2 in ppm/1000,000 

FiCO2 = iCO2 in ppm/1000,000 

FeO2 is the fractional excurrent O2 concentration, and FiO2 is the fractional incurrent O2   
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FeO2 = eO2 in %/100  

FiO2 = iO2 in %/100 

Respiratory Quotient, RQ , is the ratio of CO2 production to the O2 consumption which can be related to the 

food metabolized. 

RQ = CO2/  O2 

The following screen shows Page 4 of the setup file where manual open flow calculations of CO2, O2 

and RQ are done.  The example shown is for 8 mealworms in a 6.3 ml chamber. The reference gas was 

outside air scrubbed of CO2 with soda lime and dried with Drierite. The gas exiting the chamber was 

dried with a 13 ml Magnesium perchlorate column before entering the gas analyzers. The carrier gas 

flow was 25 ml/min. 

 

To complete the manual calculations on Page 4, the values in red columns of the table (iCO2, eCO2, iO2, 

eO2 and Flow Rate) must be entered manually.  These values are obtained directly from the raw data of 

Carbon Dioxide (ppm) and Oxygen (%) graphs shown on Page 4 (copied from Page 1).  The user has to 

manually highlight the data collected in the bypass (i.e. stop) and flush phases respectively.  Next, select 

the statistics icon from the menu (Analyze>Statistics) and obtain the averages from the statistics 

window as shown in the image below. Enter these average values into the appropriate red columns in 

the table. When the required input values are entered, the calculations (black columns) will populate 

automatically. 
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Note: All graphs can be selected by clicking on each graph while holding down the shift key.  Then select 

the data of interest on one of the graphs (e.g. Q-S151 CO2 values during the steady state response of the 

animal) by holding down the shift key and dragging the mouse over the region of interest on that graph.  

Note that data on the other selected graphs for that time period will also be highlighted.  When the data 

have been selected on all the graphs, the appropriate analysis tool can be chosen (i.e. "Statistics" 

analysis) while still holding the shift key.  The statistics will then be shown in a separate window for the 

selected data on each of the graphs.  The number of decimal places or the size of the font to be 

displayed can be changed by right clicking on the analysis window as shown below.   

  

 

Stop-Flow Calculations of ( CO2 and O2) 

 

Stop Flow (Automatic; Page 3 of Setup file): 

 

When measuring very low metabolic rates (e.g. in single small insects), the system can be used in Stop 

flow mode and the stop-flow calculations will provide the data. Although stop flow provides higher 

sensitivity, it has a much lower time resolution than the open flow method since the stop flow 

peak/trough occurs only once per stop/flush cycle. The automatic calculations provide a means of 

monitoring low respiration rates over long periods. Depletion of O2 as well as the accumulation of CO2, 

are then measured as boluses when the chamber is flushed and these gases are swept out to the gas 

analyzers. The stop flow peak/trough can be enhanced by increasing the stop time. Note the flow must 

  

  



33  

  

be low enough (~25 ml) so that the gas analyzers have sufficient time to respond to the peak/trough 

washing through. 

 

For stop flow calculations, difCO2, difO2 are multiplied by the gas flow at each sample time to produce 

difFlow graphs. difO2Flow is converted into positive values to facilitate integration of the area, i.e. 

Neg(difFlowO2) = -difFlowO2. This results in the difFlowO2 trough being converted to a peak.  The use of 

difFlow accounts for any change in flow, and more importantly, difFlowCO2 and Neg(difFlowO2) can be 

directly integrated to give respired CO2 and O2 volumes, respectively. Page 3 of the Setup file is shown 

below for automatic stop flow calculations. The same mealworm raw data discussed above for open flow 

calculations was used. CO2, O2 and RQ for stop flow peaks are automatically computed on Page 3 of the 

Setup file using the same calculations as explained below in the discussion of manual stop flow calculations 

(Page 5 of the Setup file). The computations are performed once per stop/flush cycle at the end of each 

stop peak (i.e. at FlagHigh) and plotted in the VCO2, VO2 and RQ graphs on Page 3 of the Setup file. These 

automatic graphs are useful for long term monitoring of respiration in small specimens. 

NOTE: 

To obtain accurate peak integration, the user parameters on Page 3 of the Setup file (the same ones shown 

on Page 1) (DelayLow, DelayHigh an O2delay) must be carefully adjusted by the user, either by toggling the 

arrows or selecting and typing in the desired value. If as discussed earlier, these parameters were adjusted 

by collecting a short trial run before the actual experiment and using a differential peak from the graph on 

Page 1, further adjustment will unlikely be necessary on Page 3.  If calculated data is not reasonable these 

parameters (DelayHigh, DelayLow and O2delay) should be checked and they may be adjusted after data 

collection has been completed.    

The black dot (FlagLow) on the difFlow graph on Page 3 (see graph below) corresponds to the DelayLow 

user parameter position and may be adjusted by reducing the value of DelayLow parameter (so the the left 

side of the peaks correspond to the steady state open flow level similar to the right side of the peak). The 

green dot (FlagHigh) on this graph corresponds to the DelayHigh user parameter position and should be 

adjusted on the right side of the peaks to correspond with the beginning of the steady state level after the 

peak has passed the gas analyzers. This procedure is required to ensure that only the area of the peaks 

without the open flow steady state gas levels will be used in calculations.  

The O2delay user parameter must also be carefully adjusted to align the CO2 and O2 data, so that in 

calculations requiring both CO2 and O2, these are selected from the correct period in time. This 

misalignment is due to the two gas analyzers being in series with CO2 being measured first and O2 second. 

The gas flow through the system, and tubing length between the CO2 and O2 analyzers will also contribute 

to this misalignment. The user can toggle this parameter until the correct number of samples is selected 

and the difFlowCO2 and Neg(difFlowO2) peaks are aligned.   

The stop peak areas will be calculated and graphed once per flush-stop cycle at the FlagHigh position as 

shown in the CO2, O2 and RQ graph on Page 3 of the Setup file.  
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Stop Flow (Manual; Page 5 of Setup file): 

 

Manual stop flow calculations are intended for short term experiments measuring low respiration, and 

also for teaching purposes. For calculations of CO2 and O2 in stop-flow, integrals of the CO2 and O2 

peaks in the difFlowCO2 and Neg(difO2Flow) graphs, respectively, as well as the stop time must be 

known.  

 

CO2 = CO2Vol/StopTime 

O2 = O2Vol/StopTime  

 

RQ= CO2/ O2 

 

CO2Vol and the O2Vol are the respired volumes of CO2 and O2, respectively. These volumes are 

provided by integrating the stop peaks in the difCO2Flow and Neg(difO2Flow) graphs.  StopTime (min) is 

the user parameter from Page 1 indicating the time that flow through the chamber is stopped 

(bypassed) to produce the stop peak. This value must be entered in the table on Page 5 of the Setup file.  

The following expanded graphs (Page 5 of setup file) for the same mealworm data discussed above,  

shows the integrals for the difCO2Flow and Neg(difO2Flow) peaks.  The integrals (i.e. areas under the 

peaks) were calculated using the Logger Pro analysis tool: menu: Analyze>Peak Integration 

 

Note:  1) The “Integral” analysis tool does not subtract the background levels of CO2 and O2 that are 

measured during open flow portion of the cycle  and therefore cannot be used to integrate the  peaks 

generated in stop flow, unless the background level (i.e. open flow level after the stop peak) is 

essentially zero (e.g. very small specimens).  

  

black dot 
(FlagLow) 

green dot 
(FlagHigh) 
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  2) Ensure the user parameters DelayLow, DelayHigh and O2Delay are carefully adjusted as 

discussed above for the automatic stop flow calculations on Page 3 of the setup file. Enter the 

required data in the red columns of the table. The Black columns will be automatically calculated. 

 

 

 

 

 

Installing and Running Logger Pro 3  

  

PC Users:  

  

(1) To start, a complete copy of Logger Pro 3 must be installed on the computer.  Before starting the 

installation, make sure all USB cables are disconnected from the computer.  Failure to do so may 

cause an error in the installation of the USB drivers.  

(2) Run the installation and do not change the default destination directory.  Logger Pro 3 will be 

installed in C:/Program Files/Vernier Software/Logger Pro 3.  

(3) The setup process will automatically load the USB drivers for connecting the LabQuest Mini or 

other interfaces to the computer.  

(4) If QuickTime 6 (or greater) is not installed on the computer, install it when prompted.  QuickTime 

will allow use of the picture and movie features of Logger Pro 3.  

(5) You will be prompted to connect the LabQuest Mini or other interfaces to the computer via the 

USB connection.  The LabQuest Minis can be connected to the computer by connecting the USB1 

and USB2 cables (in that order) from the Q-Box frame into the computer  

(6) Click ‘Finish’ to complete the installation process.  
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(7) Proceed to C404 installation (below) before opening the Logger Pro with the “Enhanced Q-Box 

RP1LP Setup” file.  

(8) Double click the “Enhanced Q-Box RP1LP Setup” file (create a shortcut on the desktop once 

moved from the C404 disk for easy access) to start Logger Pro and data collection. If Logger Pro 

detects the two LabQuest Mini interfaces, the Logger Pro screen will appear with two stars (icons 

for LabQuest Minis) in the top left corner.  

  

  

 
  

(9) If Logger Pro cannot detect the LabQuest Mini Interfaces, a message will appear “no device 

connected”.  Check that the LabQuest Minis are attached to the computer directly via USB 

connectors 1 and 2 on the frame of the Q-Box.  The LED power lights on the Minis should be 

green.  No LED light indicates that power is not supplied to the Minis - check power connections.  

A red LED on the minis indicates that power is on but there is no communication between the 

interfaces and the computer.  In this case, exit the “Enhanced Q-Box RP1LP Setup” file and 

disconnect the USB cables from the computer.  Reconnect the USB cables with USB1 connected 

first and USB2 second.  This order is important as the computer will assign the LabQuest Minis as 

1 or 2 according to the order in which they were connected. Allow the computer to recognize the 

Minis and then reopen the “Enhanced Q-Box RP1LP Setup” file.  

  

 
Macintosh Users:  

(1) To start, a complete copy of Logger Pro 3 must be installed on the computer (You must be using at 

least OS 9.2).  Run the “Complete Installation” and ensure all TI GRAPH_LINK and USB cables are 

disconnected. The most recent version of Logger Pro (3) is included with this package. The following 

instructions are the same as those for PC users.  
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Note: Logger Pro Software may be upgraded to the latest version, free of charge, as long as the 

original purchased version (3.0 or higher) is on the computer already.  Most recent version of 

logger pro may be obtained at the following link:  

http://www.vernier.com/support/updates/logger-pro/  

 

  

 

C404 Custom Setup Files Installation:  
 

Qubit Systems’ C404 Custom Setup Files disk contains Experimental files (designed by Qubit Systems) for 

this package.  For Enhanced RP1LP packages, the Enhanced Q-Box RP1LP Setup and the standard Q-Box 

RP1LP Setup (for use in open flow measurements of respiration) files are included. When using the 

standard Q-Box RP1LP Setup the DCU and the A380-E solenoid assembly are not used.  The C404 disk also 

contains the manual for this package, the standard package and the manual for the LabQuest mini data 

interface.  These files can be copied to a user specified location on the computer and the experimental file 

of interest “Enhanced Q-Box RP1LP Setup” should be placed in an accessible location or have a shortcut 

created on the desktop to the file.  We highly recommend the user makes a copy of the original file and 

keeps it in a safe place on the computer in case the original is accidentally altered. 

  

Using the Q-S151 CO2 Analyzer   

The Q-S151 CO2 Analyzer is a non-dispersive infrared gas analyzer (NDIR IRGA).  It has a gas “in” port 

with a female luer-lock connector and a gas “out” port with a male luer-lock connector.  Tygon tubing 

with a luer-lock connector is provided to join the Q-S151 to the rest of the gas exchange system.  The 

gas supplied to the IRGA passes through a sealed wave guide and vents from the “out” port.  The Q-S151 

can be used as a stand-alone analyzer in an open or stop-flow gas exchange system. It can be used with 

other gas analyzers downstream providing they do not cause a significant backpressure.  Increasing 

pressure significantly beyond that at which the IRGA was calibrated, produces erroneously high 

readings.  

The maximum flow of gas into the Q-S151 should not exceed 650 mL/min. The flow, is provided by the 

Q-P103 Gas pump and monitored by the Q-G266 Flow Monitor.  It is recommended the user calibrates 

the Q-S151 at the flow used during the experiments.  For open flow measurements, start with a flow of 

100-200ml/min and reduce it if the differential signal is low.  In stop-flow measurements, the 

recommended flow is 25-50ml/min. This flow may have to be reduced for very small volume chamber. 

Gases entering the Q-S151 must be clean and dry, since particulate matter may absorb infrared light and 

cause erroneous readings.  Water vapour will not interfere with the IR absorption measurement of CO2, 

but water vapour will dilute the CO2 concentration slightly.    The Q-S151 CO2 analyzer is supplied with a 

drying column containing DRIERITE.  This drying agent removes moisture from the analysis gas before it 

enters the CO2 analyzer.  Wool plugs at the base and top of the column prevent particulate matter from 

leaving the column.   

The Q-S151 CO2 Analyzer requires 12 Volts DC power to operate. A 120/220 AC power adaptor 

(included) provides 12 Volts DC.  For continuous use, keeping the Q-S151 powered up will maintain the 

calibration longer.  

http://www.vernier.com/support/updates/logger-pro/
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Caution:  Use only a 12 VDC adapter with the correct AC line voltages.  A 120/220 VAC 50/60 Hz to 

12 VDC adapter is supplied by QUBIT SYSTEMS.    

  

The Q-S151 requires a 2 to 3 minute warm-up period before the CO2 level will be displayed.  During 

warm-up, the LCD will flash numbers briefly and display the number 1.  After warm up, the LCD will 

display a very high reading, which will slowly decline to the CO2 level in the supplied gas stream.   

For most accurate and stable readings, warm up the Q-S151 for 15 - 30 min before use.  If the Q-S151 is 

to be used on a regular basis, it should be left powered on via the 12 VDC adapter.  

Altitude and Barometric Pressure Correction   

The Q-S151 is factory calibrated at sea level.  When using the IRGA at elevations other than sea level, 

calibrate at the elevation at which the analyzer will be used.  If this is not possible, correct the CO2 

reading of the analyzer according to the table below.  For example, when using a factory-calibrated unit 

at an altitude of 2,500 feet, multiply the displayed CO2 reading by 89% (1,000 ppm x 0.89 = 890 ppm 

actual).    

 

Altitude  
(feet)  

Pressure  
(inches Hg)  

Pressure  
(mm Hg)  

Pressure  
(psia)  

% Display  
Reading  

0 sea level  29.92  759.78  14.70  100  

500  29.38  746.04  14.43  97.97  

1000  28.86  732.84  14.18  95.94  

1500  28.34  719.64  13.92  93.91  

2000  27.82  706.43  13.66  91.88  

2500  27.32  693.73  13.42  89.84  

3000  26.82  681.04  13.17  87.81  

3500  26.32  668.34  12.93  85.78  

4000  25.82  655.65  12.68  83.75  

4500  25.36  643.96  12.46  81.72  

5000  24.90  632.28  12.23  79.69  

  

For other altitudes, use the following equation:  

Percentage of measured CO2 = [1- (4.06234 x 10-5 x Altitude in feet)] x 100  
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Using the Drying Column and Soda Lime Column  

The Q-S151 is designed to analyze dry gas samples.  A desiccant column is provided which is filled with 

DRIERITE to dry the gas before analysis.  The column has glass wool at both ends to prevent particulates 

from being carried through the system. It is supplied ready for use.  The column should be mounted 

vertically on the Q-S151.  

DRIERITE contains an indicator that is blue when the column is functional and pink when the DRIERITE is 

saturated with absorbed water vapour.  When spent, the DRIERITE should be replaced or reconditioned.  

To recondition, remove the DRIERITE from the column and place it in a drying oven at 210 °C for 1 hour, 

or until the blue coloration reappears.  The replacement DRIERITE is #8 mesh, order #23005 from 

DRIERITE.com.   

Note: Brand new Drierite may bind and release small amounts of CO2 slowly, thereby washing out stop 

flow peaks. The user may therefore wish to use magnesium perchlorate to remove water vapour when 

measuring very low rates of respiration. Drying gas before measurements is necessary to avoid O2 

dilution. However, magnesium perchlorate will turn into liquid if it absorbs too much water vapour, so it 

must be changed frequently.  It is recommended that a trap is installed downstream if using magnesium 

perchlorate.  Qubit Systems is not responsible for any damage caused to any components of the Q-

Box RP1LP due to magnesium perchlorate entering any part of the system.  

CO2-free gas can be obtained by pumping air through a column containing soda lime.  A small amount of 

glass wool should be placed at the ends of the column to contain small particles, and the column should 

then be filled with soda lime using a spatula.  When the column is full, it should be tapped to settle the 

soda lime, and then topped off.   The soda lime column should be used in a vertical position to ensure 

the gas has maximal contact with the crystals when flowing through the column.  

The soda lime provided with the Q-S151 has a coloured indicator to show when it is saturated with 

absorbed CO2.  The soda lime should be replaced when most of it has changed from its original white 

colour to a pale purple.  This colour change is subtle, and the purple coloration often does not persist, 

but appears as a band in the column at the junction between active and inactive soda lime.  

Replacement supplies may be obtained from Fisher Scientific (product #S200I-3).  

  

Note: remove the soda lime column from the system once calibration has been completed.  

Warning: Soda lime can cause severe burns.  Users should read and comply with the Material Safety 

Data Sheet on soda lime.  

  

Troubleshooting the Q-S151:  

 Span or zero out of range may cause “1” to appear on the display:  

Turn the “CO2 Span” all the way down (counter clockwise) and use the “Coarse Zero” on the back of the 

CO2 analyzer to display 0 with zero CO2 gas flowing through the system.  Once the zero display is read, 

attach a known CO2 concentration to the system and use “CO2 Span” to adjust the display on the CO2 
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analyzer to the correct CO2 concentration.  Return to the zero CO2 check with zero CO2 gas running 

through the system, and if necessary, make small adjustments with the “CO2 Zero”.  

Ensure no material (liquid or dust) has entered the analyzer:  

If material has entered the analyzer, it will block the internal light path and “1” will be shown on the 

display.  The unit will need to be returned to QUBIT Systems for repair.  

Ensure the Gas Flow Path in the Analyzer is Open:  

Check that there are no internal leaks in the analyzer.  Connect a 10mL syringe to a tube on the ‘OUT 

Port’ of the CO2 analyzer and plug the ‘IN Port’.  Pull a slight vacuum with the syringe.  If there is no leak, 

the plunger should not move.  If there is an internal leak, contact QUBIT Systems for further 

instructions. If the analyzer is exposed to extreme pressures, a leak can result.  

 Ensure the Pump is not Leaking.  

A faulty pump can leak room air (possible high ppm CO2) and increase the CO2 reading.  To test the 

pump, turn it on and plug the inlet.  Connect a tube to its outlet and place the tube in a glass of water.  

There should be no bubbles.  If there are bubbles, the pump is leaking internally and should be repaired 

or replaced.     

Ensure the Soda Lime CO2 Scrubbing Column is used to provide Zero CO2 gas to the analyzer:  

Do not confuse the soda lime column with the drying column filled with DRIERITE.  Soda Lime is white, 

whereas DRIERITE is blue.  If the drying column is mistaken as the CO2 scrubbing column, CO2 may enter 

the analyzer since DRIERITE absorbs some CO2, and can release it slowly thereby slowing response 

time.  If unsure of the condition of the Soda Lime in the column, replace it with new Soda Lime or use an 

alternate Zero CO2 source such as pure N2 gas.  

  

Check Calibration  

If the CO2 Span control has been adjusted without following a full calibration procedure, the analyzer 

must be recalibrated using a zero gas mixture and a gas mixture with a known CO2 level.  See the CO2 

analyzer calibration section of this manual for the correct procedure.  

The CO2 readings on the display of Q-S151 are different from those in Logger Pro  

If the CO2 values displayed on the Q-S151 CO2 Analyzer are very different from those displayed in the 

Logger Pro file, check the following.  If using the calibration saved in the Logger Pro experiment file, 

check that the calibration was done at the correct setting selected on the CO2 analyzer (0-2000ppm 

should be the default). If the range is selected correctly, check that the LabQuest Mini interfaces have 

not been reversed (check that values displayed in Logger Pro software for other sensors are correct).   If 

the LabQuest Minis have not been reversed, then the CO2 Analyzer requires a new calibration.  Proceed 

with the calibration instructions outlined on page 17.   If the LabQuest Minis have been reversed follow 

the instructions below on page 47 on how to fix the problem.  
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Using the Q-S102 O2 Analyzer  

The Q-S102 O2 Analyzer contains an O2 sensor which is a galvanic cell (a lead-oxygen battery) consisting 

of a lead anode, an O2 cathode, and an acid electrolyte.  It also incorporates an O2-permeable Teflon FEP 

membrane with a gold electrode bonded to its surface.  Oxygen diffusing through this membrane is 

reduced electrochemically at the gold electrode.  A resistor and a thermistor (for temperature 

compensating diffusion across the Teflon membrane) are connected between the anode and the 

cathode. The output of the instrument is proportional to the current flowing through the resistor and 

thermistor. This current is proportional to the partial pressure of O2 in contact with the Teflon FEP 

membrane.  The Q-S102 O2 Analyzer has two analog signal outputs, one for O2 partial pressure (Q-S102 

O2 in kPa) and one for total gas pressure (Q-S102 Pres in kPa) at the O2 sensor inside the Q-S102 

analyzer.  The total gas pressure from Q-S102 (essentially atmospheric pressure) is used in correction of 

the O2 signal in KPa to O2 in % (O2 (Pcor)).   

 

  

The galvanic cell is housed in a brass cylinder for greater temperature stability and more stable O2 signal. 

Pressure (Q-S102 Pres) is measured at the O2 cell and is displayed on Page 1 in a meter and a graph.  

This pressure is then used in software to convert the partial pressure of O2 (Q-S102 O2 in kPa) to a 

concentration (O2 (Pcor) in %) which is independent of pressure.    

O2 (Pcor)=((Q-S102 O2)/(Q-S102 Pres))*100  

The pressure corrected concentration is displayed in a meter and a graph.   

  



42  

  

 

The maximum flow through the Q-S102 O2 analyzer should not exceed 650 ml/min.  The minimum flow 

through the O2 analyzer should not decrease below 5mL/min to avoid local depletion of O2 at the 

membrane of the sensor due to O2 consumption by the electrochemical cell.  The analyzer should not be 

exposed to pressures that are above 20 PSIG or below 10 PSIG, or the damage to the sensor can result.   

The expected life of the O2 Analyzer’s galvanic cell is 3 – 5 years at which point the sensor cell needs to 

be replaced.  If it is impossible to adjust the O2 signal amplitude by adjusting the span, a new sensor is 

necessary. Contact Qubit Systems to obtain a new galvanic cell and instructions for replacement.    

 The Q-S102 is supplied with its own drying column filled with DRIERITE.  When used in series with the 

QS151 CO2 Analyzer, only one drying column is necessary (in front of the Q-S151) unless the sample gas 

is very wet.  When using the Q-S102 in a stand-alone mode, gas should be dried before entering the O2 

Analyzer to avoid O2 dilution by the water vapour. Place the drying column in the bracket mounted on 

the analyzer and connect it to the “in” port via the blue particulate filter (25μm). Check the filter 

frequently to ensure that it is not plugged.  Plugged filters will result in reduced gas flow to the 

analyzer and should be replaced.  

Troubleshooting Q-S102 O2 Analyzer  

If the O2 signal can no longer be adjusted with the “O2 Span” and the Analyzer has been used for 3-5 

years, the galvanic cell should be replaced.  Contact Qubit Systems for instructions on ordering the new 

cell and replacement procedure.  

If significant periodic jumps (0.5-1%) in the O2 readings are observed, this may indicate pressure 

damage to the Teflon membrane inside the sensor cell.  If the signal shows unexpected drift, check for 

other damage to the membrane by removing the Q-S102 O2 Analyzer from the Q-Box tray by 

unscrewing the two bolts on the back that hold the analyzer in place.  While monitoring the O2 readings, 

tilt the analyzer 90 degrees.  If there is a large change in the signal following the tilt, the Teflon 

membrane is likely damaged.  In case of damage to the membrane, the galvanic cell should be replaced.  

Contact Qubit Systems for replacement instructions.    

If small pulses in the O2 readings are observed when passing a stable O2 gas through the analyzer, this 

may indicate pressure changes in the system resulting from unstable gas delivery.   First, check the 

Total gas pressure 
at the O2 sensor (kPa) 

O2 concentration 
Corrected for 
Changes in gas 
Pressure (%) 
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system for obstructions or restriction in the gas lines.  Second, check the O2 analyzer by unplugging the 

gas supply line from it.  The reading should become stable after detaching the gas supply.  A stable 

reading when no gas is flowing through the analyzer, indicates that gas delivery to the analyzer is the 

problem.    

Unstable gas delivery may be due to the Q-P103 Gas Pump.  In an open-flow system, both needle valves 

on the Q-P103 Gas Pump should be partially restricted (as set at the time of manufacture, about 1/3 

closed from the fully open position) and the flow should be adjusted via the needle valve of the Q-G266 

Flow Monitor.   

 

  

Using the S174 Temperature Probe    

The temperature sensor is a thermistor.  It has an operational range from –40oC to +125oC.  The 

temperature sensor should not require calibration, however this is possible in the Logger Pro software 

using the menu commands Experiment>Calibrate.  The sensor is recognized automatically and 

calibration is loaded when the “Enhanced Q-Box RP1LP Setup” file is opened.  The sensor is mounted in 

a stainless steel tube, which fits through the temperature sensor ports in both types of animal chambers 

(G117 and G115-E).  The temperature sensor port in the chambers must be plugged with a stainless-

steel rod provided when the sensor is not in use (see below images).  
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Using the G122 Gas Bags  
The heat-sealed, 30 L gas bags are made from a gas-impermeable nylon-polyethylene laminate.  Tygon 

tubing is attached to each bag by a luer-lock fitting.  The fitting on the other end of the tubing attaches 

directly to the fittings on the Q-P103 Gas pump.  These bags can be filled with air from a compressor (or 

another gas mixture in a commercial tank) to provide a constant source of CO2. For long experiments, 

outside air (constant 400 ppm CO2) should be used since compressor refills may have variable CO2 

concentration if room air is used. Inside air can vary several hundred ppm in CO2 due to human breath.  

Bags should not be overinflated, as this can cause weakening of the seams and eventual leakage.  After 

use, the bags should be fully deflated, preferably by attachment to a vacuum-line or pump.     

  

Using Q-P103 Gas Pump  

The Q-P103 Gas Pump is a 1 L/min (no load) pump.  It is used in this Package to pump gas through the 

system.   The Q-P103 Gas Pump is delivered with pre-set pump speed and the flow rate through the system 

should be adjusted with the needle valve of the Flow monitor.  The two needle valves on the back of the 

pump are locked in position at the time of manufacture.   

    

  

If the pump is used in a stand-alone mode and the pump speed needs to be adjusted, it can be done 

with the two needle valves on the back.  To set the flow rate, initially fully open both needle valves on 

the back of the Q-P103 Pump (turn counter-clockwise). Reduce the flow to about twice the required rate 

using the valve beside the pump outlet (“out”).  Second, reduce the flow further to the required rate 

with the needle valve on the Gas Pump across from the “in” gas port (see photo below).    
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Turn the valves on the gas pump clockwise to reduce the flow or counter-clockwise to increase the flow.   

Once the flow is adjusted to the desired rate, use the small wrench provided in the accessory pack to 

lock both valves of the gas pump.    

 

  

  

Locking nuts on both  

needle valves should  

be tightened to avoid  

accidental changes in  

flow rate   
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A249 Battery Pack (Optional)  

 

The A249 battery pack for the enhanced Q-Box RP1LP package is composed of three Voltaic V88 

Universal Batteries.  These are Lithium Polymer batteries that can be charged directly via an AC charger 

or from a car battery via a DC charger (included).   The two batteries supply a maximum of 176 Watt 

hours of power.  Both batteries together or one at a time are connected to the Q-Box power outlet via 

the split cable provided. The third battery is used for the operation of the solenoid valves.  Use of A249 

Battery Pack allows field operation of the Q-Box RP1LP or any other Q-Box package for up to 11hr 

(without the lap top computer plugged into the battery pack).  Each voltaic battery has one “Out” port 

for plugging in the Q-Box power cable and an “In” port for connecting the AC or DC charging adaptor. 

The Voltage output from the battery to the Q-Box must be set to 12V.  

 

 

  

 The placement of the batteries in the Q-box is shown in the photo below.    

                          

Input from   charger   

Output to Q - Box    

12  V selected   
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Troubleshooting LabQuest Minis  

LabQuest Mini 1 and 2 are switched  

If the sensors show unusual values, Logger Pro software may have confused LabQuest Mini 1 with 

LabQuest Mini 2.  To rectify this situation follow these steps:  

Close the “Enhanced Q-Box RP1LP Setup” file.  Unplug the two USB cables from the frame of the Q-Box.    

 

First, reconnect one cable into the USB 1 outlet on the frame, then plug the second cable into the USB 2 

outlet.  As each LabQuest Mini is recognized by the drivers, there may be an audible beep and the 

indicator LED light on the LabQuest Minis will change from red to orange.  Reopen the “Enhanced Q-Box 

RP1LP Setup” file and proceed to assigning the sensors to appropriate channels on the two LabQuest 

Mini interfaces as follows:  

a. Ch. 1 LabQuest Mini 1 = Q-S151 CO2 Analyzer (2000ppm) 

b. Ch. 2 LabQuest Mini 1 = Q-S102 Pressure (gas pressure)  

c. Ch. 1 LabQuest Mini 2 = Q-S102 O2 Sensor (25KPa)  

d. Ch. 2 LabQuest Mini 2 = Q-G266 Flow Monitor 1LPM  
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Note: The LabQuest Mini 1 automatically recognizes the Stainless Steel Temperature 

probe (S174) in channel 3. And the digital control unit (DCU) in Dig ch 1 of Mini 2 

 

Note: An alternative method to ensure the minis are recognized in the correct order is to first open the 

Setup file then plug in min#1, wait until it is recognized (star appears in the top left corner of the menu), 

then plug in mini#2.  

  
Using Q-G266 Flow Monitor  

The Q-G266 Flow Monitor has been factory calibrated and should not require further calibration.  

However, if after extended use the flow values appear erroneous, the zero may have drifted.  To reset 

zero, adjust “Flow Zero” on the front of the instrument using the small green screwdriver provided with 

the package.  Make this adjustment with no gas running through the system, until a zero flow value is 

displayed in Logger Pro.  Do not accidentally adjust the “Flow Span”.  If “Flow Span” needs adjusting, a 

calibrated flow standard must be used.   
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It is recommended the flow rate through the Q-Box is adjusted using the needle valve on the back of the 

flow monitor.  The flow is increased by turning the valve counter clockwise, and decreased by turning it 

clockwise. Once the flow is set, lock the ring on the needle valve with the small wrench.  The data cable 

from the analog output labeled “Flow” is plugged into the data interface and the flow data is displayed 

in the software.   
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Specifications of Q-S151 CO2 Analyzer:  

• Operating principle  - Non-dispersive infrared  

• Gas sampling mode - Flowing gas stream, sealed chamber  

• Maximum gas flow - 650 mL/min  

• Measurement range (LCD display)-  0 – 1999 ppm  

• Analog output, ,  0 – 2000 ppm or 0-500ppm 

• Resolution -  ± 1 ppm  

• Repeatability (at stable atm press and temp)- Better than ±1 ppm  

• Response time (@ 250 mL/min; to 95% of final value) - ca. 25 sec  

• Warm up time (@ 22oC) – ca. 5 min  

• Output (linear) 0 – 5 VDC  

• Calibration adjustments – Zero and Span  

• Operating temperature range –  0 to 50oC  

• Storage temperature range  -  -40 to 70oC  

• Operating pressure range - ±1.5% local mean pressure  

• Humidity range -  5 to 95% RH, non-condensing (recommend drying gas stream)  

• Pressure dependence – +0.13% reading per mm Hg  

• Power requirements-  12 VDC via 120 VAC/60 Hz adapter  

• Current requirements – 125 mA average, 450 mA peak  

• Dimensions (cm) – (H x W x D: 5.5 to 9.5 x 9.5 x 17)  

• Weight - 1kg  

• Warranty - 1 year limited  

    
Specifications of Q-S102 O2 Analyzer:  

• Operating principle  - Acid Electrolyte, Teflon Diffusion Membrane  

• Detection Range - 0-25% and 0-100 %O2 (Linear)  

• Resolution - ±40 ppm   

• Accuracy ± 0.21% of Full Scale  

• Response Time (90%) - 12 Seconds  

• Life Expectancy of sensor - 3-5 years   

• Easy sensor replacement  

• Output (linear) 0 – 5 VDC  

• Influence by Other Gases - Ammonia and Ozone  

• min flow - 5 mL/min  

• max flow - 650 mL/min  

• Built in total gas pressure reading at the sensor (for pressure correction in the software)  

• Pressure Range - 0.5 atm to 1.5 atm  

• Pressure Effect - Output voltage changes proportionally   

• Shock Resistant - to 2.7 G  

• Avoid strong vibration  

• Operating Temperature - 5 to 40oC (Effective range)  

• Passive temperature control of the O2 sensor  
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• Weight – 1.35 kg  

• Dimensions (cm) – (H x W x D: 5.5 to 9.5 x 9.5 x 17)  

• Power Supply - 12 Volts 

• Warranty: 1 year  
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Qubit Systems Warranty Information  

QUBIT warrants all its instruments to be free from defects in materials or workmanship for a period of 

one year from the date of invoice/shipment from QUBIT.   

If at any time within this warranty period the instrument does not function as warranted, return it and 

QUBIT will repair or replace it at no charge. The customer is responsible for shipping and insurance 

charges (for the full product value) to QUBIT.  QUBIT is responsible for shipping and insurance on return 

of the instrument to the customer.      

No warranty will apply to any instrument that has been (i) modified, altered, or repaired by persons 

unauthorized by QUBIT; (ii) subjected to misuse, negligence, or accident; (iii) connected, installed, 

adjusted, or used otherwise than in accordance with the instructions supplied by QUBIT.    

The warranty is return-to-base only, and does not include on-site repair charges such as labour, travel, 

or other expenses associated with the repair or installation of replacement parts at the customer’s site.   

QUBIT repairs or replaces the faulty instruments as quickly as possible; maximum time is one month.   

QUBIT will keep spare parts or their adequate substitutes for a period of at least five years.   

Returned instruments must be packaged sufficiently so as not to assume any transit damage. If damage 

is caused due to insufficient packaging, the instrument will be treated as an out-of-warranty repair and 

charged as such.   

QUBIT also offers out-of-warranty repairs. These are usually returned to the customer on a cash-

ondelivery basis.    

Wear & Tear Items are excluded from this warranty. The term Wear & Tear denotes the damage that 

naturally and inevitably occurs as a result of normal use or aging even when an item is used 

competently and with care and proper maintenance.  

Return Procedure  

Before returning any instrument to QUBIT:    

Consult the operating manual or contact Qubit to ensure that the instrument(s) is in fact faulty and has 

not just been set up improperly.   

Contact QUBIT before sending anything back.  We will issue an RMA number and provide shipping 

instructions.   QUBIT will refuse any goods that are returned without an RMA number, or which are sent 

in a manner outside of QUBIT’S stipulations.  

If you have encountered a program failure, we need a printed copy of any faults you have seen, 

including how to reproduce them.  Include these in the return package along with your mailing address.   

Include a copy of the Invoice on which the product was shipped to you.   

All returns must be shipped prepaid.  Unpaid packages will not be accepted.   
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In case of questions contact QUBIT by  

E-mail: info@qubitsystems.com,  by 

phone: (01)-613 384 1977,  or by fax: 

(01)-613 384- 9118.  

  


